
One of the most important skill sets in motion graphics is
learning how to animate transformations: Anchor Point,

Position, Scale, Rotation, and Opacity. Fortunately, many rules
and techniques for creating transform keyframes can be
applied to virtually all the other parameters throughout After
Effects. And once you learn how to manipulate the handles of
a 2D Bezier motion path, you can employ these same skills
when using the Pen tool to create vector shapes for masks
(Chapter 10) and shape  layers (Chapter 32). 

In this chapter, we’ll concentrate on the
basics, including tips for avoiding many
common mistakes. You might be surprised
to see how much can be done with just one
or two animated properties and just two
keyframes per property. You’ll notice this if
you spend some time studying motion
graphics on television: A title moves left to
right (two Position keyframes). A title fades
in (two Opacity keyframes). A title grows

larger (two Scale keyframes). We bet you won’t find many titles buzzing
around the frame doing figure eights (you know who you are…).

So as not to add to your anxiety, this chapter concentrates on moving
layers in 2D space (the X and Y axes), leaving the Z axis to Chapter 13, 3D
Space. After mastering motion in 2D, just one more itsy-bitsy axis
shouldn’t be too daunting…

In the next chapter, we cover controlling speed (how layers change
over time) including how to use the powerful Graph Editor. Don’t feel
overwhelmed when you start delving into the nitty-gritty of motion
paths and velocity curves; more than likely many layers can be animat-
ed very simply. However, you will appreciate being able to make a layer
move exactly the way you want it to when the project calls for more com-
plex moves and for subtle timing changes.

In Chapter 5, you’ll increase your animation skills with tips and tech-
niques for manipulating keyframes and motion paths, as well as explore
some of the very useful Keyframe Assistants that ship with After Effects. 
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Animating a layer’s
transformations along
with mastering
motion paths. 

Example Project
Explore the 03-Example
Project.aep file as you read this
chapter; references to [Ex.##]
refer to specific compositions
within the project file. 

Basic Animation

3

Twirl down the layer, then twirl down
the Transform section to reveal the
transformation properties. In this
example, Position is animating 
(its stopwatch is on); the other
properties are at a constant value. 



Position in Time and Space
Before we delve into creating Position keyframes, it’s worth
pointing out that Position keyframes exist in both space and
time. When you animate Position you create a motion path in
the Comp panel. After Effects calls this spatial interpolation, or
how the layer interpolates between keyframes in space. This
motion path can be manipulated using Bezier handles; these
create different “flavors” of keyframes which we will explore in
depth in this chapter. 

The overall speed of the layer as it travels along this path is set
by two factors: how many pixels the layer travels between key -
frames in the Comp panel, and how many frames apart these
keyframes are in the Timeline panel. How the layer interpolates between
keyframes over time is referred to as temporal interpolation. To gain
more subtle control over its velocity, you can also manipulate 
a layer’s speed graph in the Graph Editor (covered in the next chapter).
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The motion path in the Comp panel
determines the direction the layer
travels. Spaceman object courtesy
Classic PIO/Nostalgic Memorabilia.

The overall speed of the layer is set by
how far the keyframes have to travel in
the Comp panel plus the spacing of the
keyframes in the Timeline panel (above).

You can then further tweak how the
layer travels in time by editing the
speed graph in the Graph Editor
(below), which is covered in the next
chapter. The keyframe interpolation
methods used in both time and space
are independent of each other. 

Obviously, we’re talking about two different concepts here – space and
time. By default, the keyframe flavor you choose for your motion path is
independent of the keyframe types available when manipulating the
speed in the Graph Editor. And once you are introduced to Roving
Keyframes (Chapter 4), you’ll see that space and time can even be dis-
connected from each other for the ultimate in independence!

Besides Position, other properties with values on the X and Y axes are
also considered to have a spatial component – such as Anchor Point and
Effect Point for 2D and 3D layers, as well as Cameras and Lights in 3D
(which add a Z axis, of course). In contrast, properties such as Scale,
Rotation, and Opacity do not have a spatial component.



Animating Position
Open the After Effects file 03-Example Project.aep from the Chapter
Projects folder on your DVD. To get started, create three Position
keyframes so you’ll have a motion path to play with:

Step 1: Open our first example composition, [Ex.01_starter]. We creat-
ed it at 640¥480 pixels, 29.97 frames per second (fps), with a duration of
05:00. We used CP_Spaceman.tif from this project’s Sources > Objects
folder, scaled to 40%. For this exercise, you’ll be using the Selection tool
(shortcut: V), so make sure this is selected. 

Step 2: To animate Position, you first need to turn on its animation
stopwatch. Rather than twirl all the properties down to find Position,
select the CP_Spaceman layer and press P to solo the Position property
in the Timeline panel. The current value for Position is displayed as a
value on the X (left/right, or horizontal) and Y (up/down, or vertical)
axes in the Comp panel, computed from the top left-hand corner (which
has a value of 0,0). To be precise: The Position value represents the posi-
tion of the layer’s Anchor Point (which defaults to the center of the layer)
in relation to the composition. 
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Step 2: At 00:00, click the stopwatch 
to turn it on and set the first Position
keyframe.

Stopwatch Shortcut
Option+Shift+P on Mac
(Alt+Shift+P on Windows) is 
the shortcut to turn on the
stopwatch for Position and set
the first keyframe. This shortcut
will also reveal the Position
property in the Timeline panel 
if it is currently twirled up.

T I P

Step 3: Dragging the layer to a new location creates the second keyframe
automatically and draws a motion path between both locations. 

� Turn on the stopwatch to the left of
the word Position to set the first key -
frame at 00:00. In the comp panel, click
anywhere inside the layer (avoiding the
layer’s corners) and drag the spaceman
to the bottom left-hand corner; this
updates the keyframe’s XY value. If the
Window > Info panel is open, you’ll also
see the Position value update in real
time as you move a layer. 

Step 3: Move the current time indica-
tor to 01:00, click anywhere inside the
layer, and drag the spaceman to the top
of the Comp panel. The second key -
frame is created automatically, along
with a motion path made up of dots.
Each dot indicates the position of the
layer on each frame from 00:00 to 01:00. 

Step 1: You will create your motion path
with the Selection tool (shortcut: V).
You will use the Pen tool (circled) later
when editing the path.



Step 4: Move in time to 02:00 and drag the layer
to the bottom right-hand corner to create the third
keyframe. Notice that the motion path is now
rounded at the second keyframe. (The Timeline
panel has three diamond-shaped keyframe icons,
which we won’t worry about for now.) If you got
lost, our result is shown in comp [Ex.01-final].

Step 5: Press Home to return to time 00:00 and
preview the animation by tapping the spacebar;
this Standard preview displays the motion path as
it plays, unlike RAM Preview. (We explored pre-
viewing options in depth at the end of Chapter 2.) 

Editing the Motion Path
An important concept is that most editing hap-
pens at the current time. The position of the cur-
rent time indicator in the Timeline panel indicates
the active frame. If a property is set to animate (its
stopwatch is on), changing the value of this prop-
erty at this point in time either (a) edits a keyframe
if one exists on this frame or (b) creates a new keyframe.

The exception to this rule is the motion path: You can select and move
keyframe boxes in the Comp panel without first having to move to that
point in time. Go ahead and practice moving the keyframes around (in
Chapter 5, we’ll cover moving and scaling the entire motion path). 

In the Comp panel, with the Selection tool active, select the keyframes
individually by clicking on their keyframe box and notice their associat-
ed handles that look not unlike the dots for the motion path. The first
key frame has just one handle, while the middle key frame, when it’s
selected, shows a handle on each side. (For now, resist the urge to touch
these default handles, or you’ll convert them to another keyframe type.)
The fact that the handles are drawn simply as “dots,” with no connect-
ing lines, indicates that these are all Auto Bezier key frames, the default
key frame in the Comp panel. Because the middle keyframe has both
incoming and outgoing characteristics, we’ll concentrate on its behav-
ior in the next section. 

After Effects identifies its keyframe interpolation types by important-
sounding names such as Linear, Auto Bezier, Continuous Bezier, and
Bezier. After all, without these names, we would have to refer to Bezier
as the “keyframe with handles sticking out in different directions” (or 
KWHSOIDD for short). Don’t get too hung up on the keyframe names –
it’s more important to know what the Bezier handles are doing and how
to edit them. Creating motion paths is easy; making them do exactly
what you want them to do takes a little practice! We’ve provided exam-
ples of each keyframe type in the [Ex.02-spatial keyframes] folder of
comps, so let’s take a tour…
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Step 4: The Auto Bezier keyframe is the default spatial keyframe:
Select the middle keyframe and you’ll see two “dots” on each side
of the keyframe box. These dots form an imaginary line. Note that
we’ve increased the size of the keyframe icons in the Comp panel
(Preferences > General > Path Point Size) – a new feature in CS5.

Motion Path Color
The color of the motion path 
is derived from the layer’s label
color. If you are having trouble
seeing the path, try changing
the label color (Chapter 6). 

FA C T O I D

Live Update
When you scrub the current
time indicator in the timeline,
the Comp panel should update
on the fly. If it is not updating
until you release the mouse,
check that the Live Update
button wasn’t inadvertently
toggled off.
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Auto Bezier Keyframe: The default keyframe type in the Comp
panel is Auto Bezier. Its role is to create a smooth angle into and out
of a keyframe, with no hard angles or sudden changes in direction.
In [Ex.02a], select the middle keyframe and imagine a line con-
necting the two dots on each side of the keyframe. Now imagine
another line connecting the first and third keyframes. Unless your
imagination is playing tricks on you, these two lines should be par-
allel to each other.

To see what’s automatic about Auto Bezier, move the three
keyframes around in the Comp panel by selecting their keyframe
boxes and dragging them to new positions (again, avoid dragging
the keyframe handles themselves). Notice that no matter where
you drag the keyframes, the two imaginary lines remain parallel.
One result is shown in comp [Ex.02b].

Continuous Bezier Keyframe: More often than not, you’ll end up
manually editing the default Auto Bezier handles so you can bet-
ter control the curves of the motion path. You do this by dragging
one of the default handle dots, which turns the imaginary line con-
necting the dots into real direction handles (see [Ex.02c]). 

This keyframe type is called Continuous Bezier. You’ll notice that
as you edit a handle on one side, the opposite handle moves also
(similar to a see-saw action). The two direction handles are length-
ened or shortened independently of each other, but the handles
maintain a continuous straight line through the keyframe.

Note: If you’re having trouble finding the default Auto Bezier
handle dots amid the motion path dots, press and hold down the
G key (to temporarily toggle to the Pen tool), click on the keyframe
in the Comp panel, and drag out new handles. When you release
the G key, the Selection tool should be active again. (If you actual-
ly changed to the Pen tool, press V to return to the Selection tool.)

Bezier Keyframe: For the ultimate control, you can “break” the in -
coming and outgoing handles so they operate independently – this
is the Bezier keyframe type. You can then create any combination
of straight lines and smooth curves, as we did in [Ex.02d].

To break the handles, press and hold down the G key (to tem-
porarily toggle to the Pen tool) and move the cursor over a handle
– the cursor will toggle to the Convert Vertex tool (an upside down
V). Click and drag a handle to break it. When you release the G key,
the Selection tool should be active again. 

To revert back to Continuous Bezier, just repeat the procedure:
Hold down the G key, then click and drag on a handle; the oppos-
ing handle will jump to form a continuous line again. You can also
press G and drag new handles out of the keyframe box. 

Note that if you press G and release, it will permanently toggle to
the Pen tool. We recommend you stick with the Selection tool for
basic editing (see Using the Pen Tool on the next page).
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In [Ex.02b], the orientation of the Auto Bezier
handles for the middle keyframe appear
vertical and parallel to the imaginary line
created by the first and last keyframe.

Dragging one of the Auto Bezier dots converts
the keyframe to Continuous Bezier, which
maintains a straight line through the keyframe. 

To gain independent control over the
incoming and outgoing handles, hold down
the G key and drag a Continuous Bezier
handle. This technique is a toggle.



Add, delete, and edit keyframes along a motion path
directly with the Pen tool; press G to cycle through
the various tools (above). Be sure to click directly on
the motion path, other wise you may start drawing
either a mask path or a Shape layer! (Undo if so.)
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Temporary Tools
You can temporarily toggle to some tools by
pressing and holding down the respective
shortcut key. This trick works for the Pen (G),
Zoom (Z), Rotate (W), and Hand (H) tools. 
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Using the Pen Tool
We prefer to edit motion paths with the Selection tool,
using the Pen tool only to break and retract handles. We
use the Pen tool more when  creating masks (Chapter 10)
and shape paths (Chapter 32). However, feel free to use
the Pen tool if you find it more intuitive: 

� When the Pen tool is active, dragging a handle will
break the handles and convert the keyframe to Bezier.
Press Command (Control) to temporarily switch to the
Selection tool to move a keyframe box or handle. 

� To add a keyframe anywhere along the motion path,
select the Pen tool (or Add Vertex tool) and move over
the motion path. Click on a motion path dot to create a
new keyframe on the frame represented by that dot (see
figure to the right). 

� When you move over an existing keyframe in the
Comp panel, the Pen cursor changes to the Convert
Vertex tool, and clicking the keyframe box will toggle 
it between Linear and Auto Bezier.

To convert all keyframes to Linear in one go, click on the
word Position in the Timeline panel to select all Position
keyframes, then hold down the G key and click directly
on one of the keyframe boxes.

Linear Keyframe: Up to now we’ve dealt with curves and
handles, but there are many occasions when you need
absolute straight lines and hard angles in your motion
path. You can do this by “retracting” the handles into the
center of the keyframe:

Press and hold down the G key and move your cursor
over the keyframe box (the cursor will change to the
Convert Vertex tool). Click directly on the keyframe box.
The handles will disappear, and the result is a Linear key -
frame type with a corner point. To pop out the handles
again, just repeat this technique and the Auto Bezier dots
will reappear. Note that retracting handles in this manner
works across multiple key frames: Just preselect them first
and then edit one of them.

If you hold down the G key and move your cursor over
the motion path itself, the cursor will change to the Add
Vertex tool. Click to add a new keyframe on the frame 
represented by that “dot.” Release the G key to revert back
to the Selection tool, then move and edit the new keyframe
as needed.

To change a Linear keyframe directly to Continuous
Bezier, press and hold down G to switch to the Pen tool,
then click and drag out from the keyframe box. 



Keyframe Navigation
Once you’ve created a few Position keyframes, you’ll have noticed that
the Keyframe Navigator area in the Timeline panel became active. The
navigator consists of a left and right arrow and a diamond-shaped
checkbox in the center. When the checkbox is selected (checked), this
indicates that the current time indicator is positioned exactly at a
keyframe. When the checkbox is empty, it means that you’re parked
between keyframes. 

The keyframe navigator defaults to being grouped with the A/V
Features column (Video, Audio, Solo, and Lock) on the left side of the
Timeline panel. We prefer to move this column to the far right, beside the
timeline area. (Do this by dragging the column header to the right, as
covered in Chapter 2.) After Effects will remember this preference for all
future comps. 

If you prefer to leave the A/V Features column on the left side, we sug-
gest you open the keyframe navigator in its own column: right-click on
any column head, and select Columns > Keys from the popup menu.
Then move the Keys column to the far right, by the timeline area.

To edit a keyframe value, it’s usually necessary to move the current time
indicator to that point in time; you can do this either by using the navi-
gator or by double-clicking the keyframe box on the motion path. The
natural instinct for beginners is to drag the current time indicator to a
keyframe to make it the active frame. The problem with this method is
that it’s all too easy to drag the time indicator to a frame close to the
keyframe, but not exactly on top of it. When you move the layer, instead of
editing the intended Position keyframe, you create a new keyframe just
one frame to the left or right. The two keyframes tend to overlap when the
timeline is zoomed out; so if you see a glitch in the animation, zoom into
the timeline to see if there are two keyframes where there should be one,
then delete the unwanted keyframe. You can avoid this problem entirely
if you navigate to keyframes using the navigator arrows or shortcuts (see
below). If you do prefer to drag the current time indicator, add the Shift
key and it will “stick” to keyframes, in and out points, markers, and so on.

Another method for moving the current time indicator to specific
keyframes are the following shortcuts (though they become less useful
in a complex composition with many visible keyframes):

Go to previous visible keyframe (or layer marker) J

Go to next visible keyframe (or layer marker) K

If keyframes are already applied but the layer is currently twirled up,
there are a couple of handy shortcuts you’ll want to remember. In both
cases, select the layer(s) first: 

Show all animating values U

Show all changed values UU (two Us, in quick succession)
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Skip along the Path
If a property has a motion path,
you can double-click a keyframe
box in the Comp panel with 
the Selection tool to jump to
that point in time. 

T I P

Sticky Shift
Pressing the Shift key while
dragging the current time
indicator makes it stick to
keyframes, in and out points,
and so on.

T I P

The state of the Keyframe Navigator
indicates whether the current time
indicator is positioned exactly on a
keyframe (left) or between keyframes
(right). The left and right arrows are 
a handy way to navigate among
keyframes. 

A common beginner mistake is to
navigate to keyframes by dragging the
current time indicator. If you miss by a
frame, then edit the layer, you’ll have
two keyframes one frame apart – and 
a likely glitch in your animation.



Editing Keyframes Numerically
Up to now we’ve created Position keyframes interactively by moving the
layer around in the Comp panel to set new keyframes or to edit existing
ones. Throughout After Effects, however, you also have the choice to
scrub parameter values in the Timeline panel, or enter precise values
for a keyframe directly. 

When you’re scrubbing values, press the Shift key to scrub in large
increments, or press Command (Control) to scrub in small increments.
You can also select multiple keyframes at different points in time (or
even across layers) and edit all values simultaneously: Scrub one value,
and all the selected values will be edited relative to the value you scrub.

To enter a precise value, click on the text, enter the new value, and press
Return to accept it. Again, you can enter values for multiple selected lay-
ers. Press Tab to cycle through the various visible parameter entry boxes. 

Position values are always displayed as pixel values, and defined by
the top left-hand corner of the comp. However, you can enter a Position
value using different Units: Right-click on the current value in the
Timeline panel, and select Edit Value from the popup. Select from a
number of options in the Units popup; the most useful are Pixels and %
of Composition. For instance, if you want to center a layer in the comp,
set the Units menu to % of Composition, and the X and Y values to 50,50. 

To open the Position dialog for a keyframe (without first moving to
that point in time), double-click the keyframe icon in the Timeline. If
you just want a readout of a keyframe’s Position value, right-click on its
keyframe box in the Comp panel or its keyframe icon in the Timeline;
the first item on the popup menu is the keyframe’s numerical value.

Other properties have similar dialog boxes, and the options are
 context-sensitive: For instance, editing the Anchor Point only gives you
the option to set its value to % of Source (not % of Composition), while
Rotation and Opacity offer no new options. 

Watch out for this gotcha: The numerical value shown in the Timeline
panel is the value at the current time. A common mistake is to select a
keyframe at a different point in time, then either scrub the Position value
or type a new value. This does not edit the keyframe you selected – it edits
the value at the current time, creating a new keyframe if there wasn’t one
there already. If you want to edit a specific keyframe, either double-click
the keyframe icon to open the Position dialog box, or simply navigate to
the keyframe you want to edit so that it now lies at the current time. 
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Gotcha! Selecting a keyframe elsewhere
on the Timeline, then scrubbing or
editing the Position value, does not edit
the selected keyframe – it either edits
the keyframe at the current time, or
adds a new one if none currently exists.

Anywhere you see a value that’s
underlined, you can either scrub the
values or click to enter a precise value.
Press Shift to scrub in larger increments;
press Command (Control) to scrub in
finer increments.

To bring up a dialog to edit numerically,
right-click on a value to get the Edit
Value option or double-click an existing
keyframe. The Position dialog allows
you to enter values using various
criteria. Note that the subpixel numbers
to the right of the decimal point are
used when the layer is set to Best
Quality (covered in the sidebar at the
end of this chapter).



T is for Opacity
Actually, T is for Transparency (the O key was being used already). After
Effects uses the concept of opacity, rather than transparency, so setting
the Opacity property to 0% makes a layer 100% transparent. 

To practice editing Opacity, close all comps and open [Ex.03], select
the layer, and type T to reveal this property in the Timeline panel. The
easiest way to edit it is to scrub its value in the Timeline panel, watching
the result in the Comp panel. You can also edit Opacity by clicking on its
value and entering a new number.

New keyboard shortcuts were added in CS4 to alter the Opacity of a
selected layer. Hold Control+Option (Control+Alt) and use the + and –
keys on the numeric keypad to increase or decrease Opacity in 1% incre-
ments. Add the Shift key to jump by 10% increments. (By the way, that’s
not a typo; the Mac keyboard shortcut really is Control+Option, not
Command+Option.)

When you edit Opacity, the layer’s alpha channel is being changed,
making the layer more or less transparent. In [Ex.03], press Option (Alt)
and click on the Show Channel button at the bottom of the Comp panel
to view the Comp’s alpha, and observe the results as you edit Opacity.

You’ve probably guessed already that turning on the stopwatch for
Opacity and setting two keyframes with values of 0% to 100% will fade
up a layer. Try it now, and note that the reverse will fade off a layer.

Crossed-up Dissolves
If you crossfade by fading one layer down while the other fades up, as in
[Ex.04a], you may notice a dip in the middle where both layers are at
50% opacity. If the background is black, the crossfade will result in a dip
in brightness as some of the black background becomes visible. In our
example, the checkerboard grid is turned on, so it’s partially visible.

If both layers are the same size,
you need only fade up the top
layer from 0 to 100%, as in
[Ex.04b]. Once the top layer is
fully opaque, trim out the bottom
layer (even though the bottom
layer is obscured, you may waste
time retrieving frames from disk). 

This does not always work;
problems occur when the layers
are not the same size, or have
their own alpha channels and
transparencies. Also, the layer
behind might still be partially vis-
ible and pop off, as in [Ex.04c]. In
this case, go ahead and crossfade
the two layers.

50

3 // Basic Animation

Opacity Logic
When you stack two layers on
top of each other, each with
opacity at 50%, you might
expect the result would be
100% opaque. But opacity
multiplies rather than adds.
The only way to go fully
opaque is to have a layer
somewhere in the stack that
is at 100% opacity. This fact
about opacity can cause
problems, such as when two
antialiased layers have edges
that are supposed to meet
seamlessly, or when one layer
is fading out while another is
fading up on top. Fortunately,
After Effects has cures for
these two particular cases –
the Alpha Add blending
mode (Chapter 12) and the
Blend effect (Bonus Chapter
23B), respectively.

[Ex.04a]: During a “cross”
dissolve, both layers are
partially transparent, in 
this case revealing the
checkerboard transparency
grid behind. This is not
always desirable. Footage
from Artbeats/ White Puffy
Clouds and Washington DC.



Fading Layers as a Group
When you fade down multiple layers indi-
vidually, you will end up with a “staggered”
fade-out, as in [Ex.05a]. The solution is to
fade out the layers as a group after they’ve
been composited together. There are two
ways to do this:

� [Ex.05b]: Add Layer > New > Adjustment
Layer and apply Effect > Distort > Transform. Then set keyframes for the
Opacity parameter in the Transform effect. This works because the
Adjustment Layer gets a copy of the composite of all layers below, and
the effect fades it out. (Adjustment Layers are covered in Chapter 22.)

� [Ex.06]: Composite the layers in one comp (a precomp), as we did in
[Ex.06a]. Then nest this comp into a second comp, [Ex.06b]. Animating
Opacity in the second comp will apply to the group of layers after they’ve
been composited together. Nesting is covered in Chapter 18; you can also
use Precomposing (Chapter 19) to move a group of layers to a precomp.

S is for Scale
Next you’ll learn how to manipulate the Scale property of a layer in 
a variety of ways, and pick up a few shortcuts and tips while you’re at it.
In this chapter’s project, close any open comps and open [Ex.07]. Select
the AB_WashingtonDC.mov layer in the Timeline panel, and type S –
this is the shortcut to twirling down just the Scale property for a select-
ed layer. You will see two values: the first one is X Scale, representing the
layer’s width; the second one is Y Scale, representing its height. There
are a variety of ways to edit Scale:

� The simplest way to edit Scale is to scrub its value. This works similar-
ly to scrubbing the Position value (discussed earlier in this chapter):
scrub to the left or right and the size of the layer will
be updated in the Comp panel. If you scrub the value
below 0%, the image will flip and start growing again
because you are now entering negative Scale values.
If you find the values change too fast as you scrub,
press the Command (Control) key to scrub in finer
increments. Conversely, holding Shift while you’re
scrubbing will update Scale in increments of 10%. 

� You can also edit Scale numerically by clicking on one of the values,
entering a new number, and pressing Return. 

� If you want to change the X and Y Scale values independently from
each other, click on the chain link icon to the left of their values to turn
off the aspect ratio lock switch. Clicking again in the empty box where
the chain link used to be will turn the aspect lock back on; now chang-
ing one of the Scale values will update the other and automatically main-
tain the same aspect ratio. 
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To edit Scale in the Timeline, select 
the layer, type S to expose the Scale
property, and scrub its values. The chain
link icon indicates that the X and Y Scale
values are locked together; the aspect
ratio of the layer will be maintained as
you change either value. 

[Ex.05b]: One method for fading out
multiple layers as a group is to apply the
Transform effect to an Adjustment Layer
and animate the effect’s Opacity value. 

Vital Statistics

Hover your cursor over a
keyframe in the Timeline panel
to display a tooltip containing
its time and value. This tooltip
does not update if you drag a
keyframe in time; keep an eye
on the Window > Info panel to
 verify its new timing.
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To see this in action, turn off the
aspect lock, set the Scale values to
some easy-to-remember relation-
ship such as X = 100% and Y = 50%,
and turn the aspect lock back on.
If you then scrub or change the X
Scale value to 60%, the X Scale will
automatically change to 30%, keep-
ing the same 2:1 aspect ratio.

Here’s a handy shortcut for
resetting the X and Y Scale to have
the same values: If the chain link
icon is on, first turn it off. Then
press Option (Alt) as you turn back
on the chain link; the Y value will
snap to the X value. The aspect
ratio will be locked so they contin-
ue to stay in sync.

� You can also edit Scale interactively by dragging the handles that
appear around a layer’s outline in the Comp panel. The trick is to add the
Shift key after you start dragging to maintain the aspect ratio of the layer
as you scale. Note this changes X and Y Scale independently, but does
not disable the aspect ratio lock switch.

� For even more control, right-
click on one of the values and
select Edit Value to open the Scale
dialog box. Here, you also have the
option to change the units you use
for Scale to % of Composition or
Pixels, as well as the less useful
inches or millimeters. There is also
a popup menu in this dialog to
preserve the aspect ratio of the
layer as you edit; this mimics the behavior of the chain link icon in the
Timeline panel. When the layer has been animated, you can also  double-
click a Scale keyframe to open this dialog.

� Added in CS4: You can scale in 1% increments holding down Option
on Mac (Control – not Alt – on Windows) and using the + and – keys on
the numeric keypad (not the regular keyboard). To practice this, make
sure the layer is selected, then press Option + (Control +) to increase
Scale by 1% and Option– (Control–) to decrease Scale by 1%. Add the
Shift key while you’re doing this to change Scale in 10% increments.

Note that no matter which method you use for changing scale, the
origin for all scaling (as well as rotation) is the layer’s Anchor Point (the
icon in the center of the layer that looks like a crosshair). Changing the
Anchor Point is covered later in chapter.
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Stretch to Fit
Command+Option+F
(Control+Alt+F) will force a layer
to scale, rotate and position
itself to fit the size of the 
comp exactly. Even more such 
options can be found under 
the Layer > Transform menu.

T I P

You can scale a layer directly in the
Comp panel by dragging its handles;
add the Shift key after you start
dragging to maintain the aspect ratio.
If the layer displays a colored outline
rather than handles, it has a mask
applied; if so, turn off the Toggle Mask
and Shape Path Visibility button at the
bottom of the Comp panel (see arrow).



53

Basic Animation // 3

Try animating Position, Scale and
Opacity, as we did in [Ex.08-final].
Try to avoid scaling a layer above 100%.
This forces After Effects to create new
pixels without enough information 
from the source image, resulting in a
softer image.

Animating Scale
Now that we know several different ways to manipulate Scale, it’s time to
animate it. You can practice this in [Ex.08_starter]: 

Step 1: Select the CP_Spaceman.tif layer, and type S to reveal the Scale
property in the Timeline panel.

Step 2: Make sure the current time indicator is at the beginning of the
comp (press Home if it’s not), and enable the stopwatch for Scale. This
enables animation and sets the first Scale keyframe at the current time
using the current size as its value. 

Step 3: Still at time 00:00, change the scale of the layer (bearing in mind
that values over 100% will blow up pixels and decrease quality). 

Resetting Scale
To return the Scale value of a
selected layer back to 100%,
double-click the selection 
arrow in the Tools panel.

T I P

Step 4: Move the time indicator later in time and rescale the spaceman
to a size different from the first keyframe. Notice that a new keyframe is
automatically created in the Timeline panel. Whenever Scale’s stopwatch
is on, changing the Scale results in a keyframe being created at that point
in time, or updated if there was already a keyframe at that point in time,
just as with Position keyframes.

As you scrub the time indicator along the timeline, notice that the
spaceman changes size between keyframes, as After Effects automatical-
ly interpolates the Scale values.

Once you get the hang of animating Scale, try also animating Position
and Opacity for the layer if you need the practice. With Scale revealed
already in the Timeline panel, select the layer and press Shift+P to also
reveal Position, and Shift+T to add Opacity. Remember that the three
properties are independent of each other; you don’t need to create the
same number of keyframes for each property or have them appear at
the same points in time. RAM Preview your animation at any time. 
Our example of all three properties animating is in [Ex.08-final].

Steps 1–4: To animate Scale, enable the
stopwatch to set the first keyframe, and
create at least one more keyframe at a
later point in time with a different Scale
value. Remember that you can use the
keyframe navigator to jump between
Scale keyframes, as well as set new
keyframes and delete existing ones.



R is for Rotation
The Rotation property has its own set of keyboard shortcuts and
alternate methods of manipulation that are worth learning. Close
any open comps and open [Ex.09]. Select the CD_bikewheel layer,
and type R on the keyboard – this is the shortcut for revealing just the
Rotation property. The value shown is in Revolutions + Degrees, with
positive numbers rotating clockwise from 0°. As with Scale, there are
a variety of ways to edit Rotation:

� The easiest way to edit Rotation is to scrub its value in the
Timeline panel. With the Rotation property revealed, scrub the right-
most value (degrees) to the right or left, watching the wheel rotate in
the Comp panel. As you drag past 359°, you will notice that the num-
ber of whole revolutions change as the degrees start over again from
0. Holding Command (Control) as you scrub gives you finer control;
holding Shift jumps degrees by multiples of 10.

� You can edit Rotation numerically by clicking on its value in the
Timeline panel to highlight it, typing in a new value, and pressing
Return. The Tab key jumps between the revolutions and degrees val-
ues. If you enter a value of 360 or larger, After Effects will automat -
ically convert it to the correct number of full revolutions plus the
remaining number of degrees. 

� To offset the current Rotation value by 1° increments, make sure
the layer is selected, then press the + or – key on the numeric keypad
(not the regular keyboard). If you add the Shift key while you’re doing
this, Rotation will change in 10° increments.

� You can interactively rotate a layer in the Comp panel with the
Rotation tool (shortcut: W for Wotate – seriously, that’s what they 
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You can rotate 2D layers interactively in 
the Comp panel using the Rotation tool
(shortcut: W). If the Selection tool is active,
remember that you can temporarily switch
to the Rotation tool by pressing and
holding down W; the cursor in the Comp
panel will change to the rotate cursor.
Rotate the layer and release the W key 
to return to the Selection tool.

Rotation Rules
After you’ve rotated a layer a few times in a graphics
program such as Adobe Illustrator or Photoshop, it’s
often difficult to reset the orientation back to the
starting position (before it was ever rotated). This 
is because once rotation is processed, the image 
reassumes a rotation value of 0. 

When you rotate a layer in After Effects, however,
the value displayed is always in relation to the 
original starting value of 0°, and you can always
return to this original rotation value at any time. 
It’s also worth pointing out that the Rotation value 
of a single keyframe does not indicate how the layer
will animate. For instance, a keyframe value of 90°

does not necessarily mean the layer has just rotated
clockwise 90°. That would be true only if the previous
keyframe had a value of 0°. 

In [Ex.11_starter], both wheels rotate from 0° to
180° clockwise over two seconds. If you now wish 
the wheel to animate counterclockwise by 180°, the
third keyframe should be set to 0° (not minus 180° 
as you might think).

So gauging whether a layer is rotating clockwise
or counterclockwise can only be accomplished by
checking the values of keyframes before and after
the current keyframe, or by consulting the Value
Graph in the Graph Editor (Chapter 4).

Select a layer and press R to reveal Rotation
in the Timeline panel. As you scrub the
rightmost parameter – degrees – past 359°,
the revolutions value to the left will increase.



told us). Add the Shift key after you start dragging to constrain Rotation
to 45° increments. If you make a mess, double-click the Rotation tool 
to revert to 0°.

Animating Rotation
If you’d like to practice animating rotation, follow these steps using
[Ex.10_starter]:

Step 1: Select the CD_bikewheel layer and press R if Rotation is not
already revealed in the Timeline panel. 

Step 2: Make sure the current time indicator is at 00:00 and click on
the stopwatch icon to the left of the word Rotation. This enables anima-
tion and sets the first Rotation keyframe at the current time. We’ll use the
current rotation amount – 0° – for this keyframe. 

Step 3: Move the current time indicator to a different point in time and
scrub the rotation value in the Timeline panel to create a new keyframe.

Step 4: Move to another point later in time, press and hold down the 
W key to temporarily switch to the Rotation tool, and rotate the wheel
interactively in the Comp panel to create the third keyframe. (If you acci-
dentally changed tools, press V to revert to the Selection tool.) 

Press 0 to RAM Preview the comp to see the effects of your animation.
Again, double-clicking on a keyframe is another way to edit a keyframe
numerically by opening that property’s dialog box. 

Our version is [Ex.10-final], where we’ve also animated Scale. RAM
Preview; did you notice the animation seamlessly loops? This is because
we set the same values for Scale and Rotation at the beginning and end,
then placed the last two keyframes one frame after the end of the comp
(at 04:00) so that this value wouldn’t be repeated when the animation
loops. To get to this “extra” frame, press End to jump to the last frame of
the comp (03:29), then press Page Down to advance one frame. The
Comp panel will be grayed out, but you can still edit the keyframes!
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Auto Rotation
Auto-orientation (Chapter 5)
can automatically orient a layer
along its motion path, with no
rotation keyframes necessary!

T I P

In [Ex.10-final], the wheel both rotates
and scales (left). The animation creates
a seamless loop thanks to the first and
last keyframes being identical, and the
last two keyframes being placed one
frame after the last frame (below).

If rotated layers look a bit “sliced” or
aliased, check that the Comp panel’s
Magnification is set to 100%, the layer’s
Quality switch is set to Best Quality (the
default), and the comp’s Pixel Aspect
Ratio Correction switch is off.



An Orientation in 3D Rotation
When 3D space was added in After Effects, the Rotation property went
from having one parameter to having four: Orientation, plus individual
X, Y, and Z Rotation. Let’s explore how this works.

Open [Ex.12a] and make sure the regular 2D Rotation property is
exposed for the CP_MedicalArm.tif layer. Scrub its value; watch it rotate
clockwise and counterclockwise in the Comp panel. Rotation, like Scale,
occurs around the layer’s anchor point (covered in the next section).
Leave Rotation at some value other than 0°, then turn on the layer’s 3D
Layer switch (the cube icon at the right side of the Switches column). 
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3D Terminated
Turning off the 3D Layer switch
wipes out the Orientation plus
the X and Y Rotation values,
keeping just Z Rotation.

G O T C H A

When the 3D Layer switch is enabled (circled in red), you
get three Rotation properties plus Orientation (above).
The three colored Rotation arrows in the Comp panel
(right) show you what axis you are rotating around.
Image courtesy Classic PIO/Classic Medical Equipment.

Solo Selected 
To reduce the number of
properties revealed in the
Timeline, select just the ones
you wish to see and press SS 
to solo them. This is especially
useful when you wish to solo
parameters that don’t have
their own shortcuts, such as
effect parameters.

T I P

You will now see the four parameters mentioned above: Orientation,
X Rotation, Y Rotation, and Z Rotation. Notice that the value you left
Rotation at before enabling the 3D Layer switch was copied into Z
Rotation. 2D Rotation revolves an object like a pinwheel around the axis
pointing out of the layer straight toward you – the Z axis (the blue col-
ored arrow). 

� Scrub the Z Rotation value to confirm that it rotates not unlike a 2D
layer. The axis it’s rotating around (the blue arrow) is hard to see because
it’s pointing straight toward you. Double-click the Rotation tool to set
the Z Rotation back to 0° when you’re done. 

� Scrub the X Rotation – the layer will tumble around the X axis (red
arrow). Undo or set the value back to 0°.

� Scrub the Y Rotation – the layer swivels around the Y axis (green arrow).

� Now rotate the layer using all three Rotation values – X, Y, and Z – and
see how any orientation in 3D space is possible.  

These three rotational parameters are sometimes referred to as the
layer’s Euler rotation. They are the values you will be keyframing most
often when you want to animate a layer’s rotation. They each have their
own line in the Timeline panel, meaning they each have their own key -
frames (and their own graphs in the Graph Editor). This independence



allows you to do things like spin a layer like a top 20 times
around its Y axis, while you slowly wobble it back and forth
along its Z axis.

Double-click the Rotation tool to set all three Rotation
parameters back to 0°, and turn your attention to the
Orientation property. Notice that it has X, Y, and Z values; as
you scrub them, they initially seem to act just like the indi-
vidual Euler Rotation parameters. But notice the lack of a
“number of rotations” value: Orientation is mainly used for
posing, rather than animating, a layer. This will become evi-
dent when you keyframe these different parameters:

In [Ex.12b], two different animations are taking place. (If
the keyframes aren’t visible, select both layers and press U.)
The upper arrow has its X, Y, and Z Rotations animated from
0° to 300° and back. The lower arrow’s Orientation property
is animated using the same values. If you scrub the current
time indicator or RAM Preview the comp, you will notice that
the Orientation animation moves only a little, while the
Rotation arrow layer gyrates wildly. This is because Orientation
uses what is called Quaternion interpolation, where it takes
the shortest path between keyframes – instead of spinning
the exact number of degrees you requested. So in our exam-
ple, layer 1 rotates 300 degrees between the first and second
keyframes, while layer 2 takes the shortest route and rotates
negative 60° to arrive at the exact same “pose”!

You’ll learn more about working in 3D space in Chapter 13.
In the meantime, remember that you can enable the 3D
Layer switch any time you need to do a quick swivel and tilt
– you don’t need to add cameras and lights and create a
whole 3D world! 
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QuickSearch fields appear in the Project and Timeline panels.
These make it much easier to find specific sources or para-
meters, as well as comments in these panels. To try this out 
in the Timeline, open [Ex.13-final]; select layers 1–4 and
Command (Control) click on the twirly arrow to the left of
layer 1. Quite a daunting list of parameters! To search the
selected layers for a particular parameter – say, Color – type
“color” into the QuickSearch field. Try other parameter
names, such as “position” or “drop”.

To clear the QuickSearch field, click the X that appears on
the right side when a search is active; all layers will twirl up.
To search all layers, deselect all layers first (shortcut: F2). 

QuickSearch

Using QuickSearch allows you to reveal just the
parameters you’re looking for.

When the Rotation tool is selected, a popup menu
appears on the right side in the Tools panel. Here 
you can toggle the tool’s behavior between editing
Orientation or Rotation values for a 3D layer. 

You can rotate the X, Y and
Z axes of a 3D layer
interactively in the Comp
panel (above); place the
cursor over the axis you
wish to rotate around until
the cursor changes to this
axis, then click and drag.
Move away from the arrows to rotate freely (inset).
That said, be very careful using the Rotate tool to
alter Y Rotation or Orientation: There is a nasty
anomoly that if you go beyond ±90°, the X and Z
values flip by 180° (try it!). That’s why we prefer
scrubbing the values directly in the Timeline panel.



Auto-keyframe Mode
Now that you’ve had some experience with animating Position, Scale,
Rotation, and Opacity, you’ve seen how important it is to turn on the
animation stopwatch for the correct property if you want your actions 
to be recorded. New users often forget this step and change property
values interactively in the Comp panel – only to realize later that After
Effects didn’t capture any of their changes! Auto-keyframe mode – a new
feature in CS5 – aims to solve that problem.

When Auto-keyframe mode is on, modifying a property automatical-
ly turns on that property’s keyframe animation stopwatch and adds a
keyframe at the current time. Try this approach in our next example:

� Open [Ex.13_starter], where we’ve already placed four layers that
make up the title “All That Jazz” along with a background layer (which is
locked). Note that the 3D layer switch is enabled for the four title layers
so you can rotate them in 3D (as you practiced on the previous page). 
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I Remember U
Pressing U for a selected
layer, or layers, twirls down
all properties that have their
stopwatches set, while UU
(two Us in quick succession)
also twirls down properties
that have changed from
their default settings.

T I P

Enable Auto-keyframe mode.
Now any changes you make
to a layer, either interactively
in the Comp panel or by
scrubbing values in the
Timeline, will create a
keyframe automatically. 

� Enable Auto-keyframe mode by clicking the large
stopwatch icon along the top of the Timeline panel.
Its center turns red. Note that Auto-keyframe mode is
now on for all comps in this project, not just this one.

� At 00:00, select layer 1, All That, and drag the X axis
arrow (the red one) to move the layer to the right so it
resides completely on the pasteboard. (Selecting the
X axis means that it won’t move up or down acciden-
tally; with a 2D layer you could add the Shift key after
you start moving to restrain horizontally.)

� Press U; the stopwatch for Position is on and the
first keyframe has been created. Move to 01:00, and
scrub the X value in the Timeline to return the layer to
its original position. This creates the second keyframe.

Once Auto-keyframe mode is enabled,
moving the All That layer to the
pasteboard on the right side
will turn on the stopwatch
for Position and create the
first keyframe. Moving the
layer back to its original
position will create the
motion path (above) and
the second keyframe (right).



� Return to 00:00, and select layer 3, Jazz. Select the
Rotation tool and check that the Set popup in the
Tools panel is set to Rotation (not Orientation). In the
Comp panel, rotate the layer around its X, Y, and Z
axes. Press R to reveal Rotation in the Timeline; the
X, Y, and Z Rotation properties are all set to animate
(see figures to the right).

� Press V to return to the Selection tool, move later 
in time, and set all three values back to 0° – this will
create a second set of keyframes.

After Auto-keyframe mode is enabled, editing any
parameter will add a keyframe for it. However, the act
of enabling Auto-keyframe does not create any
keyframes at that moment. If you want to create a
first keyframe that contains a parameter’s current
value, it is safer to manually toggle on the stopwatch
for that property. 

Auto-keyframe mode is set project-wide, not per
comp – so remember to turn it off when you’re done!
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Flip & Flop
Negative scale values are normally used to flip a layer horizontally or vertically (although you can also use 3D
Rotation to flip a layer horizontally or vertically). Open [Ex.90-Flip & Flop] and make sure its Scale property is
exposed in the Timeline panel (select the layer AB_IndustryScenes.mov and press S if not).

� Click on the chain link icon to turn off the aspect ratio lock, then click on the X Scale value and type “–100”
and press Enter. The movie in the Comp panel will flip horizon tally and the smoke will now flow out of the
smokestack from right to left instead. Turn the aspect lock back on and scrub either value to rescale the
flipped image. The shortcut for this technique is to select Layer > Transform > Flip Horizontal.

� To flip a layer vertically, enter a negative value for the Y value, or select Layer > Transform > Flip Vertical.

The Layer > Transform menu commands do not affect existing keyframes. Note that After Effects also has
Flip, Flop, and Flip + Flop Animation Presets. These work by adding a Transform effect to the layer, leaving its
Scale value – and any existing Scale keyframes – untouched. Animation Presets are covered in Chapter 25.

An image can be flipped horizontally or vertically by entering negative scale values for one or both dimensions. Shortcuts
were added to the Layer > Transform submenu in CS4 to perform the same tricks. Footage from Artbeats/Industry Scenes.

Original Flip Horizontal
Scale: –100%, 100%

Flip Vertical
Scale: 100%, –100%



A is for Anchor Point
Central – quite literally – to changing the position, scale, and rotation of
an image is its anchor point. This is the pivot around which these activ-
ities take place. Judicious placement and animation of the anchor point
will result in more predictable movements. Once you have a good grasp
on the anchor point, we will show you how to use it to simulate 2D
motion control moves.

Close your previous comps, and open [Ex.14] in this
chapter’s example project. This comp is 640¥480 in size,
with a blue solid that is the same size as the comp. Select
the solid layer, and notice the anchor point in the center
of the layer (it looks like a registration symbol). Press A to
solo Anchor Point, and Shift+P to add Position so only
these two properties are displayed in the Timeline panel.
Make sure that Auto-keyframe mode is turned off. 

Both Anchor Point and Position appear to have the same values on the
X and Y axes, so how do these numbers differ? Move the layer in the
Comp panel and notice that only the value of Position has changed. The
value of Position is the position of the layer’s anchor point relative to the
comp (in other words, the Position’s X and Y axes are in comp space).
Undo until the layer returns to the center of the comp.

Because the Layer panel docks with the Comp panel, we suggest you
split the Comp viewer for this exercise so you can view both panels side
by side: With the Comp panel active, press Command+Option+Shift+N
(Control+Alt+Shift+N) to get two viewers. The new viewer on the right
side will be locked. Double-click the layer to open the Layer panel (intro-
duced in Chapter 2) in the left viewer (see figure below). In the Layer
panel, the anchor point should be visible in the center of the layer. 
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The anchor point is the pivot around
which layers scale and rotate; it defaults
to the center of the layer. It’s important
to note that anchor point X and Y values
are relative to the layer, while Position’s
X and Y values refer to the anchor
point’s position in the Comp panel. 

As you move the anchor point in the Layer panel (left viewer), its value updates in the Timeline, and the layer is offset in the
Comp panel (right viewer) in the opposite direction. Notice the position of the anchor point in the Comp panel does not change.

Layer
panel Comp

panel



In the Layer panel, grab the anchor point with the mouse and move
it around. As you do so, watch the Comp and Timeline panels. You will
notice that the anchor point stays in the same place in the Comp panel,
but the edges of the layer move to match the distance between the
anchor point and the layer edges in the Layer panel. Also note that only
the value of the anchor point parameter changes in the Timeline panel.
The anchor point value is the position of the anchor point relative to the
layer (in other words, the anchor point’s X and Y axes are in layer space).

When you move the anchor point in the Layer panel, the image will
appear to move in the opposite direction in the Comp panel. Obviously,
this is not very intuitive! But the Position property has no sense of the
layer’s boundaries; it only keeps track of where the anchor point is in
the comp. Considering that the anchor point’s location in the Comp
panel has not changed, but the position of the anchor point relative to
the layer has, it makes sense that the layer is “offset” in the Comp panel.
Fortunately, it’s easy to reposition the layer in the comp so that your lay-
out appears unchanged. (Chapter 5 covers moving a motion path.)

When working with anchor points, set the
Layer panel’s View popup to Anchor Point
Path. Although you can drag the anchor
point in the Masks view (the default), the
Anchor Point Path view also allows you to
nudge it using the cursor keys, and to see its
motion path (if it is animating). 

Remember that when you move the anchor point, then scale and
rotate the layer, the image will anchor itself around this new position.
With some images it’ll be obvious that scale and rotation should happen
around a certain point – the center of a wheel or gear, for instance.
Because of the offset behavior mentioned above, it’s best to decide on
the location of the anchor point as soon as you drag the layer into the
comp – before the layer’s Position property has been animated over time.

Moving Anchor and Position Together
As you’ve discovered, in order to change the center of rotation and scale
without changing your layout, you have to move the anchor point and
then reposition the layer in the Comp panel. But can’t we do this in one
step? This is where the Pan Behind tool comes in handy: It can edit these
two properties at the same time. 

To use the Pan Behind tool (shortcut: Y), click directly on the anchor
point in the Comp or Layer panel; as you move the anchor point, the
layer maintains the same visual position in the comp. It achieves this feat
by changing the value for both Anchor Point and Position at the same
time. Try it in [Ex.14] while watching how these parameters update in the
Timeline panel. Beware: This is of little use if Position is already animat-
ing – unless you want to make a mess of your motion path! But, if you set
the anchor point in the Comp panel before creating Position keyframes,
it sure beats fussing about in the Layer panel. 
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To temporarily switch to the Pan Behind
tool, press and hold down the Y key, 
edit the anchor point, then release the
mouse to return to the previous tool.

Anchor Point Reset
To set the anchor point back to
the center of a layer, right-click
on its value in the Timeline
panel and select Edit Value.
In the Anchor Point dialog, set
the Units popup to % of Source,
then set both the X and Y
values to 50.

T I P

Pan Behind What ?!
Don’t mistake the Pan Behind
tool for an innocent “move” tool.
It’s real purpose is to pan an
image behind a window
created by a mask (see Chapter
10), while keeping the mask’s
position stationary in a comp.

G O T C H A



It is also possible to edit just the anchor point value
in the Comp panel without affecting the value for
Anchor Point: Select the Pan Behind tool, then hold
the Option (Alt) key while you’re dragging the anchor
point in the Comp panel. This has the same effect as
dragging the anchor point in the Layer panel with the
Selection tool. To practice this alternate method:

� Close the second (rightmost) comp viewer and
open comp [Ex.15_starter] which consists of a simple
3D wireframe of a tire and wheel. The Title/Action
Safe grid should be enabled. You can see that the
anchor point is centered in the comp, but if you press
0 to RAM Preview the animation, you’ll see how the
tire wobbles as it rotates. This is because the tire is
not centered in relation to the source layer. 

� To fix this, press Z to select the Zoom tool, then click to zoom into the
Comp panel so you can see more detail. 

� Press Y to select the Pan Behind tool, then press Option (Alt) and drag
the anchor point up and to the right. Notice how the anchor point stays
in the same place and the wheel “slides” around behind it. Release the
mouse when the wheel is centered in the comp. Because only the
Anchor Point value changed, not the value for Position, the wheel con-
tinues to rotate around the center of the comp. Preview the animation
again and tweak until the wobble is cured, as in [Ex.15-final].

Of course, you could have used the original technique and arrived at
the same result: Double-click the layer to open the Layer panel and use
the Selection tool to reposition the anchor point to the wheel’s center.
But it’s nice to have options.

Anchor Point Examples
The project file includes several examples of the benefits of manipulat-
ing the layer’s anchor point:

� Open comp [Ex.16_starter] and RAM Preview: An
attempt is made to rotate an artificial arm, but the
anchor point is centered in the original footage item.
The arm pivots about this center, rather than mov-
ing from the imaginary shoulder joint, as we would
expect it to. To fix this, use the Pan Behind tool (Y) in
the Comp panel to reposition the anchor point at the
left end where you imagine the joint should be and
preview again. Return to the Selection tool (V) when
you’re done. Our version is in [Ex.16-final].

Remember that you can also position the anchor
point outside of the layer’s boundary. Then, when
you animate Rotation, the layer will rotate in an arc.
See [Ex.17] for an example. 
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In [Ex.15_starter], you’ll need to re-
center the anchor point to remove the
wobble when the wheel rotates. In the
Comp panel, with the Pan Behind tool
selected, press Option (Alt) and drag 
the anchor point to center the wheel.
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3D Anchor Point
When the 3D Layer switch is
enabled, the anchor point can
be offset in Z space as well,
allowing 3D orbits. We’ll discuss
this further in Chapter 13.

T I P

To animate the arm rising and falling using simple rotation,
its anchor point should be placed at the shoulder joint
(where the arrow is pointing). 



� To demonstrate how the anchor point works when scaling a layer,
open comp [Ex.18a] and RAM Preview. We created a series of transitions
in which a layer stretches from one corner or side to the other. For
instance, if we set the anchor point on the left side of a layer, and ani-
mate Scale from 0% width to 100% width, the layer stretches horizontal-
ly from the left side.

� [Ex.18b] takes this idea further, coordinating keyframes so one layer
appears to “push” another off as they scale. Notice that Hold key frames
(discussed in the next chapter) are used for Anchor Point and Position
so that a layer can push in from the left side, then be pushed out to the
right side later, or even return to scaling from the center.

Orbiting Objects
One of the simplest and most useful things you can do by offsetting an
anchor point is to have one object rotate around another, as demon-
strated in comp [Ex.19_orbit-final]. RAM Preview, then select the top
layer and press U to twirl down its keyframes; only Rotation is animat-
ing. Let’s re-create this effect from scratch:

Step 1: Open comp [Ex.19_orbit_starter]. Drag the
CD_sputnik.tif (found in the Project panel’s Sources
> Objects folder) to the left side of the Timeline panel
so it defaults to being centered in the Comp panel.
Do the same for the CD_planet_loop.mov (found in
Sources > Movies). It’s important that both layers
share the same Position value.

Step 2: Make sure the sputnik layer is on top of the
planet layer in the layer stack. Since it is large in rela-
tion to the planet, select the sputnik layer, press S to
reveal Scale, and scale it to around 50%.

Step 3: With the CD_sputnik.tif layer still selected,
press A to reveal its Anchor Point and scrub its X value
until the anchor point is centered horizontally in the
sphere (about X = 66), then scrub its Y value until the
sputnik is positioned above the planet (about X = 320).

Step 4: At time 00:00, press R to reveal Rotation and
turn on its stopwatch to set the first keyframe at 0°.
For the second keyframe, press End to jump to the
end of the comp (05:29), then press Page Down to
advance to 06:00, one frame after the end (the Comp panel will be gray).
Click on the value for Rotation, enter a value of –1 Revolutions + 0
Degrees, and press Return. Press 0 to RAM Preview your animation. The
sputnik appears to revolve counterclockwise around the planet, using its
new anchor point, which just so happens to be the center of the planet.
It seamlessly loops because the value of the keyframe one frame after the
end is a whole revolution from the starting keyframe. 
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[Ex.19]: To make one object orbit
another in a perfect circle, it’s easier
to offset the layer’s anchor point 
and animate its rotation than it is 
to create a circular motion path 
with Position keyframes.

[Ex.18b]: Coordinating Anchor Point,
Position, and Scale keyframes allows
one layer to “push” off another layer.
Images courtesy Getty Images.



Motion Control Moves
The ultimate use for the anchor point is creating 2D motion control
moves, popular for panning around photographs. Perhaps the most well-
known example of this is the documentary The Civil War: A Film by Ken
Burns. Traditionally, motion control involved placing photo graphs on a
stand, then having a camera zoom and pan around them. 

This technique is easy to replicate – with greater control and higher
quality – inside After Effects. It’s important to start with an image that’s
much larger than the comp size so you can avoid scaling past 100% at
your tightest zoom, which would result in a softer, lower-quality image. 

You could animate Position keyframes, but problems will creep in as
soon as you try to simulate a zoom by animating Scale as well: Because
layers scale around their anchor point, your image will slide around the
frame. An example of what can go wrong when you animate Position
and Scale is shown in [Ex.20a] – RAM Preview to see how the layer drifts.
Select the DV_Beauty_eye.jpg layer and press the comma key to reduce
the magnification; notice that the anchor point starts on the pasteboard,
so scaling occurs around this point, not the center of the Comp panel.
Sometimes this problem is barely noticeable, but the larger the image is
compared with the comp size or the more off-center the detail you want
to zoom in on, the more exaggerated the problem becomes.

How do you keep the anchor point centered? Easy: Center the Position
of the layer in the Comp and animate the Anchor Point property instead.
The anchor point now becomes the “crosshairs” your virtual camera is
aimed at as you pan around an image. Comp [Ex.20b] shows the same
move and zoom, but with animating the anchor point instead; now the
focal point of the image no longer wanders away.

Smooth Operator
If you would like to practice this, re-create a similar motion control move
from scratch. Use our image or one of your own:

Step 1: Open [Ex.21_starter]. Open the Sources > Stills folder in the
Project panel, select DV_AllThatJazz_duo.tif, and press Command+/
(Control+/) to add it to your comp – this places its Position (and there-
fore its Anchor Point) at the center of the comp. Don’t reposition it!

Step 2: Press A, then Shift+S, to twirl down Anchor Point and Scale in
the Timeline panel. At 00:00, turn on the stopwatch for both properties. 

Step 3: Select the Comp panel and press Command+Option+Shift+N
(Control+Alt+Shift+N) to get two viewers so you can see the Layer and
Comp panels side by side. Select the left viewer, then double-click the
layer to open the Layer panel. You will be working mainly in the Layer
panel, so adjust the magnification to allow you to see the entire image.

Step 4: Our photo consists of two musicians: a pianist and a trumpet
player. Our camera move will travel from a close-up on the pianist’s
hands to a shot that includes both of their faces. 
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[Ex.20a]: Because scaling occurs
around the anchor point (circled above),
if you animate Position and Scale on 
an image that is much larger than the
comp, the image may appear to drift 
off toward the pasteboard. Model
courtesy Digital Vision/Beauty.

Step 2: Turn on the stopwatches for
both Anchor Point and Scale. 

More Than Stills
This technique is not limited 
to still images – you can use
moving sources or a nested
comp (see Size Doesn’t Matter
in Chapter 18). Remember that 
the source should be larger
than the output size so you
don’t need to scale above 100%.

T I P



Select Anchor Point Path from
the Layer panel’s View menu. Now
drag the anchor point in the Layer
panel and notice that the location
of the anchor will be what’s cen-
tered in the Comp panel (provided
the position of the layer is still in the
exact center of the comp). Position
the Anchor Point so that you nicely
frame the pianist’s hands.

Step 5: Move the current time
indicator later in the comp – say,
around 08:00. In the Layer panel,
drag the Anchor Point to the faces
area so you have a nice initial fram-
ing in the Comp panel. Reduce the
Scale value to zoom back a bit, and
notice that because the Anchor
Point is centered in the Comp
panel, the image does not slide off
toward the pasteboard. In fact, ani-
mating Scale results in behavior not
unlike zooming in and out with a
real camera! Make sure you don’t
accidentally pan or scale the image
so far that part of the comp’s back-
ground is revealed. 

Step 6: RAM Preview. Not a bad
start; here are a few improvements: 

� The anchor point’s motion path
in the Layer panel can be edited just
like Position; try pulling Bezier han-
dles to introduce a gentle curve.

� To smooth out the speed changes, select all the keyframes and press
F9 to apply the Easy Ease keyframe assistant (discussed in Chapter 4).

� It can look more realistic if the rate of change is not exactly the same
for both the Anchor Point and Scale properties – real camera operators
aren’t that smooth! In [Ex.21-JazzGuys_final], we moved the first anchor
point keyframe to 01:00 to linger longer on the hands. You can also adjust
their speed graphs in the Graph Editor (Chapter 4) to add variety.

� Add a very slight “wiggle” to the anchor point and scale animations to
reduce the ultra-smooth move and better simulate a traditional motion
control rig. This is best done with the wiggle expression (Chapter 37).

� If you find the move starts to “strobe” during the faster sections, con-
sider using Motion Blur (Chapter 8).
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Step 4: Move the anchor point in the Layer panel (left viewer) so the hands on
the piano are nicely framed in the Comp panel (right viewer). Image courtesy
Digital Vision/All That Jazz.

The Kid Stays in the Picture
An update on this technique 
is to cut objects of interest out
of their backgrounds and to
perform moves in 3D space. 
We cover this technique in a
column we originally wrote for
Artbeats, which is included on
the DVD in the Goodies folder.

T I P

Step 5: Our second keyframe set zooms
back and pans up to their faces
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Transform Keyboard Shortcuts
Here is a handy set of shortcuts to remember when you’re working with the transform properties. 
(Shortcuts in parentheses are the Windows equivalents.)

Reveal property in Timeline panel:

Anchor Point A Rotation R

Position P Opacity T

Scale S To add/subtract Shift + property reveal key

Turn on property stopwatch Option+Shift (Alt+Shift) + respective reveal key (above)

If stopwatch on, add/delete keyframe Option+Shift (Alt+Shift) + respective reveal key (above)

Show all animating properties U

Reveal modified properties UU

Solo selected properties SS

Hide property or category Option+Shift (Alt+Shift) + click property or category name

Select all keyframes for property Click property name

Set value in dialog box Command+Shift (Control+Shift) + P, S, or R

Constrain Scale to aspect ratio Drag layer handle to start scaling, then add Shift

Constrain Rotation to 45° increments Rotate with tool, then add Shift

Reset Scale to 100% Double-click Selection tool

Reset Rotation to 0° Double-click Rotation tool

Nudge Scale + 1% and –1% Option+ (Control+) and Option– (Control –) (plus and minus keys) 

on the numeric keypad (add Shift to scale plus/minus 10%)

Nudge Rotation + 1° and –1° + (plus) and – (minus) keys on the numeric keypad 

(add Shift to rotate plus/minus 10°)

Increase/decrease Opacity + and –1% Control+Option (Control+Alt) + (plus) and – (minus) keys

on the numeric keypad (add Shift to rotate plus/minus 10°)

Stretch layer to fit Comp size Command+Option+F (Control+Alt+F)

Stretch layer to fit vertically only Command+Option+Shift+G (Control+Alt+Shift+G)

Stretch layer to fit horizontally only Command+Option+Shift+H (Control+Alt+Shift+H)

Auto-Orient dialog (see Chapter 5) Command+Option+O (Control+Alt+O)



Keyframe Tips and Gotchas
The concept of key frames comes from traditional animation: The mas-
ter animator would draw the important frames of a scene, while others
filled in the frames in-between. In the digital world, you determine the
keyframes, and the computer calculates the frames in-between by inter-
polating intermediate values. 

If you are new to animating with keyframes, below are some general
tips as well as some common gotchas to help you avoid frustration:

� Be sure to turn on the stopwatch for the specific property you wish to
animate (a layer’s movement would be Position, to animate its size
would be Scale, and so on). 

� There is no animation unless you create at least two keyframes with
different values at different points in time. 

� Turn off Auto-keyframe mode as soon as you are done with it, or you
will find extra keyframes all over the place. You’ve been warned…

� Turning off the stopwatch deletes all the keyframes for that property. 

� Don’t enable the stopwatch for every property on the first frame of a
layer. If you do, you’ll be forced to return to the first keyframe at the
beginning of the layer to make a global change; you might also create
unwanted animation by accidentally adding keyframes later in time. 

� When you want a property to animate, the first keyframe does not
need to occur at the beginning of the layer. For instance, if you want a
title to fade out at the end, place two Opacity keyframes (100% and 0%)
at the end of the layer. The layer will start out using the value of the first
keyframe (100%) until it passes the first keyframe, at which point it will
start to interpolate down to 0%. There’s no need for a keyframe of 100%
at the start of the layer.

� When properties are set to animate, there’s no equal-opportunity rule
that says they must all have the same number of keyframes all synced 
to the same points in time! Create keyframes only where needed for 
each property: The fewer keyframes you have to manage, the easier the 
animation will be to edit.

� On the other hand, when multiple properties are animating together,
it’s usually best to apply the same amount of ease in and out to key -
frames that do align in time. (Examples of this are in the next chapter.)

Remember: Creating motion graphics begins with motion, and manip-
ulating transformation keyframes is a large part of the job. Another very
important skill is controlling how layers animate over time, and that is
the subject of Chapter 4. We’ll cover more animation tips plus some fun
and useful keyframe assistants in Chapter 5.

Before you move on, we encourage you to experiment and have fun
until you feel comfortable with the basic animation techniques covered
so far in this chapter. Create a new comp and design your own anima-
tion. Go ahead – it’s only software; you can’t break anything!
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Layer panel, RAM Previewing: Chapter 2.

Graph Editor, hold keyframes: Chapter 4.

Moving and scaling motion paths, auto-orient
rotation, keyframe assistants: Chapter 5.

Managing layers: Chapter 6.

Trimming layers: Chapter 7.

Motion blur: Chapter 8.

Anchor point in 3D: Chapter 13.

3D space: Chapters 13–16.

Parenting: Chapter 17. 

Nesting compositions: Chapter 18.

Animating effects: Chapter 22.

C O N N E C T

To Keyframe, or 
Not to Keyframe
Not all animation in After
Effects results from creating
keyframes:

� Some effects (such as
Distort > Wave) self-animate –
they create an animation at
their default settings.

� Expressions (Chapter 37)
can make a property wiggle
or loop as well as create more
complex animations, all
based on JavaScript.

� Behaviors (Chapter 25) use
a combination of effects and
expressions to automatically
animate a layer without using
keyframes. For example, the
Drift Over Time behavior
moves a layer in a certain
direction at a certain speed.

� Further examples include
the Wiggly Selector for a Text
Animator (Chapter 21) and
the Wiggle Paths option for
Shapes (Chapter 32).
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In Search of the Perfect Pixel

As a motion graphics designer, delivering a high-
quality render to your client is of the utmost concern.
If you are new to After Effects, however, you may have
concerns about why pixels appear less than perfect.
Note that many of the solutions involve techniques
“not yet in evidence,” so feel free to review this
checklist when the need arises. We hope it will help 
you determine if the artifacts you are seeing are tem-
porary, trivial, or really need fixing:

� The image in the Comp panel looks “crunchy.”
Solution: Check if Magnification is set to less than
100%. This is a temporary display issue and nothing
to worry about! See Navigating in Space, Chapter 2.

� The Comp panel is at 100%, but images appear
“blocky.” Solution: Check that the comp’s Resolution
is set to Auto or Full. See Resolution, Chapter 2.

� Magnification is set to 100%, Resolution is at Auto
or Full, but images are still “crunchy.” Solution: Check
if the Pixel Aspect Ratio Correction switch is toggled
on at the bottom of the Comp/Layer/Footage panel.
See Working Square, Chapter 41.

� Layers are not moving smoothly, or they look
aliased when rotated or scaled. Solution: Check that
the layer’s Quality switch is set to Best, which makes
layers move smoothly and antialiases them when
they are transformed or distorted. See Subpixel
Positioning (next page), and Quality, Chapter 2.

� The layer is set to Best Quality, but you’ve applied 
a blur or distortion effect and it doesn’t render
smoothly. Solution: Check if the effect offers different
levels of antialiasing in the Effect Controls panel, and
if so, set the Antialiasing popup to High.

� Imported still images look a little softer in After
Effects than they do in Photoshop or Illustrator.
Solution: Create artwork in other programs where 
the width and height are an even number of pixels.
See Resampling in Action (next page). 

� Images in the Comp panel look “fat,” and circular
objects look like eggs. Solution: D1/DV pixels are not
square, so this could be correct behavior if you have
placed a square pixel image into a D1/DV NTSC or

PAL comp. Non-square pixels are discussed in
Chapter 41, Video Issues, along with correct frame
rates and frame sizes for video output as well as
working with anamorphic widescreen sources.

� There are horizontal lines running through a movie
in the Comp panel. Solution: The movie is interlaced,
and you need to separate the fields in the Interpret
Footage dialog. See Fields and Pulldown, Chapter 38,
and Fields and Interlaced Frames, Chapter 41.

� Movies in the Comp panel are alternating
between sharp and soft. Solution: The source movie’s
frame rate may not be in sync with the Comp’s frame
rate. Select the source in the Project panel and open
File > Interpret Footage > Main. Then conform the
source’s frame rate to the correct rate – 29.97 frames
per second (fps) for NTSC video, 25 fps for PAL, and so
on. (Even if it says the movie is 29.97 already, conform
it anyway…) See Frame Rate, Chapter 38.

� You play back a rendered movie on a television
monitor, and some parts are “flickering” slightly.
Solution: You may need to selectively blur these 
high-contrast areas. See Field Flicker, Chapter 41. 

� You play back a field-rendered movie on a video
monitor, and the flicker is really, really bad. Solution:
The field order of the movie may not match the 
hardware chain and the fields therefore may be
reversed. See the Field Render options in Chapter 42,
Render Queue.

� You render a movie with an alpha channel, and
when you composite it in your editing program, it
has a black “fringe.” Solution: Render with a straight
alpha channel, not the default premultiplied alpha.
This is discussed in the Color section of Output
Module Settings, Chapter 42. 

� You render with an alpha channel and the movie
looks really ugly when viewed in QuickTime Player.
Solution: Congratulations, you successfully rendered
a straight alpha channel, but QuickTime Player is
showing you only the RGB Channel with the extra
“bleed.” Import this movie into your editing program
– and relax!
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Subpixel Positioning
When a layer is set to Best Quality (the default), it 
will use subpixel positioning; this allows a layer to be
positioned using less than one pixel for smoother
motion. How much less? After Effects resolves to 
16 bits of sub pixel resolution, so each pixel is divided
into 65,536 parts width and height. With that kind 
of resolution, there are more than 4 billion subpixels.
Technically speaking, that’s known as “a lot.” 

To see the numerical results of this precision, park
the current time indicator between two interpolating
Position keyframes, select the layer and press
Command+Shift+P (Control+Shift+P) to open the
Position dialog. The dialog will show values for the 
X and Y axes for 2D layers: Numbers to the left of 
the decimal point are the integer values used by
Draft Quality, while the fractional numbers indicate
the subpixels used by Best Quality. 

When a layer is set to Draft Quality, movement is 
calculated using whole pixels only. While this lets 
you set up keyframes and preview them more
quickly, you might find the results a little bumpy.

In addition to smoother motion, Best Quality 
also ensures that effects and transformations are 
rendered with full antialiasing. Draft Quality renders
without antialiasing (this is particularly noticeable
with vector artwork such as Text layers, Solid layers, 
or Illustrator sources).

Resampling in Action
A benefit of Best Quality and subpixel positioning is
that layers are antialiased (or resampled) when they
are transformed. While good antialiasing is desirable
(especially with distortion effects), the softness that
resampling adds can be unwanted when you’re just
placing, say, a non-moving image or title created in
Illustrator or Photoshop in your comp at 100%. 

To avoid this unwanted resampling, we need to
understand why and when it kicks in. As it happens,
After Effects resamples a layer whenever it uses 
subpixel positioning, and that means whenever the
difference between the Anchor Point value and Position
value is not a whole number. Check out the following
example comps in this chapter’s project:

� [Ex.99a]: Your layer is even sized, 300 pixels wide
by 300 high, which places the Anchor Point in the
center at 150,150. You place this image in an even-
sized 640¥480 pixel comp and Position it in the
center (320,240). The difference between 150,150
and 320,240 is a whole number, so the layer does not
get resampled. Toggle the layer between Draft and
Best Quality, and you’ll see that there is no change.

� [Ex.99b]: Toggle the layer between Draft and
Best, and see the image shift and soften slightly.
This is because this layer is odd sized, 301 pixels wide
by 301 high, which places the Anchor Point at

150.5,150.5. When it’s positioned in the middle of
this even-sized 640¥480 pixel comp, the difference
between 150.5,150.5 and 320,240 is not a whole
number, so the layer will be resampled. 

As you can see, you can avoid resampling for non-
moving images by creating sources with even sizes 
in Photoshop or Illustrator. If all else fails, you can
always avoid unnecessary resampling by changing
the Position of the layer by a half pixel up or down,
left or right, until the image pops into sharpness.

When Position is interpolating between keyframes,
check out the current value – the subpixel numbers 
to the right of the decimal point are used when the
layer is set to Best Quality (the default). 


